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F-Secure PSB Administrator's Guide 

¶ Introduction 
This guide is divided into chapters that give you general information about F-Secure 
PSB software, its deployment and installation.  

¶ Getting Started 
This chapter explains how to get started with the F-Secure PSB software.  

¶ Installing F-Secure PSB Workstation Security 
This section describes the system requirements for installing and using the product, and 
gives you instructions on how to install the product.  

¶ Upgrading from Policy Manager 
This chapter explains how to upgrade your system from F-Secure Policy Manager to F-
Secure Protection Service for Business (PSB).  

¶ Checking the system status 
The portal shows you the security status of the computers in your network and points to 
any security problems that you should fix.  

¶ Managing product settings 
This chapter explains how you can set up the product locally through the program 
installed on your computer, or remotely using the F-Secure PSB portal.  

¶ Managing profiles 
You can create, edit, or remove profiles using the profile editor.  

¶ Frequently asked questions 
This chapter answers the most frequently asked questions.  

 

 



Introduction 

This guide is divided into chapters that give you general information about F-Secure PSB 
software, its deployment and installation. 

 

Getting Started 

This chapter explains how to get started with the F-Secure PSB software. 

In this chapter, you find instructions how to create a new account to log into the F-Secure PSB 
Portal, and to download and install the F-Secure PSB software. 

¶ Creating a new account 
You need to create a new account to log into the F-Secure PSB Portal.  

¶ Downloading Software 
You can download the F-Secure PSB Workstation Security, F-Secure Server Security, or 
F-Secure PSB E-mail and Server Security software through the F-Secure PSB Portal.  

¶ Recovering your password 
If you have forgotten your password, you can recover it through the Forgot your 
password link.  

 

Creating a new account 

You need to create a new account to log into the F-Secure PSB Portal. 

To create a new account: 

Note: If you have created an account, for example, for F-Secure PSB Workstation Security, do 

not create a new company account, but add a new subscription to the existing account. 

1. In your browser, go to the URL that was provided to you together with the subscription 
key. You received the URL and the subscription key, for example by e-mail, when you 
purchased the product. The F-Secure Protection Service login page opens.  

 



2. Click theCreate your account link. The Create account page opens.  

 

3. Enter the required information:  
 

o In the Subscription key field, enter the subscription key that you received, for 
example by e-mail, when you purchased the product.  

o In the Account name field, enter the name of the company.  

o In the User name field, enter the e-mail address of the user. The e-mail address 
is used as your login name.  

o In the Password and Confirm Password fields, you must enter exactly the same 
passwords.  

o In the E-mail field, enter your e-mail address.  

4. ClickCreate your account. You will receive an e-mail message that shows your account 
information.  

5. ClickBack to the login page. The F-Secure Protection Service login page opens.  

6. Log in to the F-Secure PSB Portal.  

 

Downloading Software 

You can download the F-Secure PSB Workstation Security through the F-Secure PSB Portal. 

To download the software: 

1. Log in to the F-Secure PSB Portal. Enter the user name and password, which you 
selected when you created your account. The Protection status page of the new account 
opens.  



 

2. Click the Download software link at the top of the page. The Download software page 
opens.  

 

3. In the Download software page, click the Download the workstation softwareor the 
Download the server software link.  

 

Recovering your password 

If you have forgotten your password, you can recover it through the Forgot your password 
link. 

To recover your password: 

1. On the log in page of the F-Secure PSB Portal, click Forgot your password? link.  

2. Enter your user name, and click Submit.  

An e-mail message is sent to the e-mail address that you provided when you created the 
account. The e-mail message contains a link to the F-Secure PSB Portal where you can change 
your password. 

 

 

 



Installing F-Secure PSB Workstation Security 

This section describes the system requirements for installing and using the product, and gives 
you instructions on how to install the product. 

¶ System requirements 
Read the following before starting to install and use F-Secure Workstation Security.  

¶ F-Secure PSB Workstation Security local installation 
This section describes how to locally install F-Secure PSB Workstation Security.  

¶ F-Secure PSB Workstation Security remote installation 
This section explains how to remotely install F-Secure PSB Workstation Security.  

 

System requirements 

Read the following before starting to install and use F-Secure Workstation Security. 

Your computer must meet the following minimum requirements for installing and using the 
product: 

Operating system 
version: 

Microsoft Windows 2000 SP4 

Microsoft Windows XP (32-bit). All service packs: 

 

¶ Home, Professional and Media Center editions  

Microsoft Windows Vista (32- and 64-bits). All service packs: 

 

¶ Starter  

¶ Home Basic  

¶ Home Premium  

¶ Business  

¶ Ultimate  

¶ Enterprise  

Processor: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ Intel Pentium III 600Mhz or higher  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ Capable of running Microsoft Vista 32-bit  



Memory: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ 256 MB  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ 512MB  

Display: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ 8-bit (256 colors)  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ 16-bit or more (65000 colors)  

Disk space: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ 600MB free HD space (300 MB for Anti-virus only)  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ 600MB free HD space (300 MB for Anti-virus only)  

Internet connection: An Internet connection is required in order to validate your 
subscription and receive updates. 

Browser: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ Internet Explorer 5.0 or newer is required.  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ Internet Explorer 7.0 or newer is required  

Supported browsers for using the F-Secure PSB portal: 

 

¶ Internet Explorer 6.x or newer is required. JavaScript and 
cookies must be enabled in the browser 

¶ Firefox 2.x or newer is required. JavaScript and cookies must 
be enabled in the browser  

Note: To use Profile Editor, you need to have Java Runtime 

Environment 1.6 or newer installed on your computer. 

The following are the recommended requirements for installing and using the product: 



Processor: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ Intel Pentium III 1Gz or higher  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ Intel Pentium 4 2GHz or higher  

Memory: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ 512 MB or more  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ 1 GB or more  

Display: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ 16-bit or more (65000 colors)  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ 16-bit or more (65000 colors)  

Disk space: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ 800MB free HD space (500 MB for Anti-virus only)  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ 800MB free HD space (500 MB for Anti-virus only)  

Internet connection: An Internet connection is required in order to validate your 
subscription and receive updates. 

Browser: For Microsoft Windows XP and Windows 2000 (32-bit): 

 

¶ Internet Explorer 6.0 or newer  

For Microsoft Windows Vista (32- and 64-bits): 

 

¶ Internet Explorer 7.0 or newer  

 

 

 



F-Secure PSB Workstation Security local installation 

This section describes how to locally install F-Secure PSB Workstation Security. 

To install the program: 

1. Locate the downloaded file and double-click the.exe file to start the installation.  

2. Select the installation language, and click Next to continue.  

3. Read the license agreement. To accept the agreement and to continue, click Accept.  

4. Enter your subscription key and click Next. You must enter the same subscription key 
that you used when you created the account.  

 

5. Select the installation type, and click Next:  

o Automatic installation: The product is installed automatically. Existing security 
products may be automatically replaced. The product is installed to the default 
directory.  

o Step by step installation: During the installation, you can change the installation 
directory. However, we recommend using the default directory.  

6. When the installation is complete, the computer restarts automatically after a while. To 
restart immediately, click Restart.  

After the installation, log into the Portal to verify that the computer shows in the Portal. 

 

 



Note: In the Protection status page, you may see a green status icon with the text "Waiting for 

connection." It may take up to two hours before the connection is established. If the computer 

has not yet received the latest updates, you may see either a yellow or a red status icon. For 

more details on the computer(s), click the Computers tab to open the Computers page. 

 

F-Secure PSB Workstation Security remote installation 

This section explains how to remotely install F-Secure PSB Workstation Security. 

Before you start the remote installation, make sure that the domain controller exists and that the 
computers on which you want to install the software belong to a domain. To be able to remotely 
install the software, you must have domain administrator rights. 

To install the software: 

1. Log in to the F-Secure PSB Portal. Enter the user name and password, which you 
selected when you created your account. The Protection status page of the new account 
opens.  

2. Click the Download software link at the top of the page. The Download software page 
opens.  

3. In the Download software page, click the Download the Remote Installation Tool link. 
If you have not downloaded the workstation software yet, click also theDownload the 
workstation software link.  

4. Extract the Remote Installation Tool zip file on a local drive.  

5. Double-click the ritool.bat file. The F-Secure Remote Installation Tool window opens.  

6. In the Software to Install page, click . The Software Installer Selection window opens.  

7. Locate the downloaded workstation software file and click OK.  

8. Click Next.  

9. In the Target Computers page, do the following:  

a. Under Domain Name, select the domain to which the computers belong.  

b. Under Computer Name, select the computers on which you want to remote install 
the software.  

10. Click Next.  

11. In the Account page, do the following:  

a. Select Another account.  

b. Enter the domain administrator name and password.  

c. Confirm the password.  

12. Click Next.  

13. Click Install. The workstation software is being installed on the selected computers.  

In the F-Secure PSB portal, verify that the computer shows in the portal. 

 



Upgrading from Policy Manager 

This chapter explains how to upgrade your system from F-Secure Policy Manager to F-Secure 
Protection Service for Business (PSB). 

To upgrade your system: 

1. In the F-Secure PSB portal, create an account, if not yet created.  

2. Login in to the portal.  

3. At the top of the Protection status page of the account, click the Download software 
link. The Download software page opens.  

4. Click the Download the workstation software JAR installer for PMC link.  

5. In the F-Secure Policy Manager Console, from the Tools menu, select Installation 
packages. The Installation Packages window opens.  

 

6. Click Import.....  

7. In the Import Installation Package window, locate the correct file, and click Open.  



8. Click the Installation tab. 

 

9. Under Policy Domains, select the computer or group of computers on which you want to 
install F-Secure PSB Workstation Security.  

10. On the Policy-based Installations pane, under Versions to Install, select the correct 
version, and click Start. The Installation Options window opens.  

 

11. Do the following:  

a. Enter the subscription key.  

b. Select the installation language.  

c. Select the Restart after installation in [ ] seconds option.  

12. Click Finish. Distribution packages are being created.  

13. When the packages have successfully been created, from the File menu, select 
Distribute Policies. The next time the computes connect to the policy management 
server, they download and install F-Secure PSB Workstation Security, and restart after 
the installation.  

After the installation, verify that the computers are registered to the F-Secure PSB Portal. You 
can then remove the computers from the F-Secure Policy Manager Console. 



Checking the system status 

The portal shows you the security status of the computers in your network and points to any 
security problems that you should fix. 

¶ Is my network protected? 
The Home page shows you the overall protection status of your network.  

¶ Checking the status of a group of computers 
You can check the status of computers that belong to the same group, that have the 
same subscription key or that share the same problem.  

¶ Checking the status of computers 
On the Computers page, you can check the overall protection status of computers.  

¶ Checking the status of a workstation 
You can view detailed status information of a workstation on the Computers page.  

¶ Keeping computers in the network safe 
You keep all the computers in the network safe.  

¶ Get updates by RSS 
You can subscribe to an RSS feed.  

 

Is my network protected? 

The Home page shows you the overall protection status of your network. 

On the Home page, the pie chart shows the proportions of the network computers that are 

protected, or that have either minor or critical problems.  

Note: The portal shows information only about the computers that are registered to the portal. If 

you have computers that are not registered to the portal, they may be a security risk. 

The list on the right shows network information by each security component. If you only see 
green icons, all computers are protected. You can also see the overall number of the accounts 
and computers in your network. 

 

Checking the status of a group of computers 

You can check the status of computers that belong to the same group, that have the same 
subscription key or that share the same problem. 

¶ Viewing computers that have the same problem 
You can view all the computers that have the same problem.  



¶ Viewing computers that belong to the same group 
You can view all the computers that belong to the same group.  

¶ View computers with the same subscription key 
You can view all computers with the same subscription key.  

 

Viewing computers that have the same problem 

You can view all the computers that have the same problem. 

To view the computers: 

1. On the Home tab, click one of the links that show the number of computers with a 
specific problem. For example, "virus definitions are very old in 3 computers". The 
Computers page opens.  

2. You can view the computers that have the same problem.  

 

Viewing computers that belong to the same group 

You can view all the computers that belong to the same group. 

To view the computers: 

1. On the Home tab, click the Computers tab. The Computers page opens.  

2. Click the Central Managementtab.  

3. In the Central Managementview, do one of the following:  

o Click the Group column title to sort the computers by their group name.  

o Enter the name of a group in the Search box at the top right corner of the 
computer list, and click Search. The number of computers belonging to the group 
is shown. Click the link to view all the computers in the group.  

 

View computers with the same subscription key 

You can view all computers with the same subscription key. 

To view computers: 

1. On the Home tab, click the Computers tab. The Computers page opens.  

2. Click the Installed software tab.  

3. In the Installed software view, click the Subscription key column title to sort the 
computers by their subscription key. You can view the computers with the same 
subscription key also by first selecting the company the subscriptions of which you want 
to see. Then, click the View subscriptions for this account link to see all the subscription 



keys of that company. On a Subscription key line, under Active computers, click the 
Show computers link to see all the computers with the same subscription key.  

 

Checking the status of computers 

On the Computers page, you can check the overall protection status of computers. 

The Computers page shows you detailed information about the computers that are registered to 
the F-Secure PSB Portal. 

 

By clicking the different tabs, you can view the following: 

 

¶ the protection status of computers by a security component;  

¶ computer information, such as DNS names and IP addresses;  

¶ information about software installed on the computers;  

¶ and account information, including information about the company, Solution Provider 
and Service Partner associated with a computer.  

The Computers page may show different computers depending on how you opened the page. 

The Computers page may show: 

 

¶ all the computers in the network that are registered to the portal.  

¶ all the computers that have the same problem,  

¶ all the computers that have the same subscription key.  

Note: If there are more computers that can fit on one page, click Next>> to see the rest of the 

computers. 



Checking the status of a workstation 

You can view detailed status information of a workstation on the Computers page. 

The Computer page shows a list of all computers in your network. To view detailed information 

about a workstation, under Computers, click the name of the workstation. The information 

includes: 

 

¶ recently assigned operations  

¶ recent alerts  

¶ overall protection status of each security component  

¶ protection status of each feature in a security component  

¶ computer information, including the WINS- and DNS-name, IP address, and operating 
system  

¶ software installed on the workstation, including the product name, subscription key, 
version, and security components  

¶ account information, including information about the company, Service Partner, and 
Solution Provider associated with the account  

 

Keeping computers in the network safe 

You keep all the computers in the network safe. 

To keep the computers in the network safe, do the following: 

1. Make sure all your computers are registered to the portal.  

2. Check whether any of the computers that are registered to the portal have security 
problems. Some of these problems you can fix directly from the portal; some of these 
problems you may have to fix locally.  

3. Check which users need a more strict security profile.  

 

Get updates by RSS 

You can subscribe to an RSS feed. 

To be able to read the RSS feed, you need an RSS reader. These include: 

 

¶ Web based readers, such as Google reader (www.google.com/reader),  

¶ Bloglines (www.bloglines.com), or  

¶ built-in RSS readers in web-browsers, such as Mozilla Firefox 2 or Internet Explorer 7.  



An RSS feed shows you the security status of the network without you having to log into the F-
Secure PSB portal. 

To get security updates by RSS: 

1. Click at the top right corner of the Home page. The RSS feed page opens.  

 

2. From the drop-down menu, select the application which you want to use to subscribe to 
the RSS feed.  

3. Copy the web address into you RSS reader.  

 

Managing product settings 

This chapter explains how you can set up the product locally through the program installed on 
your computer, or remotely using the F-Secure PSB portal. 

¶ Managing the product settings locally 
This section explains how you can locally manage the product settings.  

¶ Managing the product settings remotely 
This section explains how you can remotely manage the product settings by assigning 
profiles or operations.  

 

Managing the product settings locally 

This section explains how you can locally manage the product settings. 

The Home tab shows you a quick overview of your security components and the status of the 
installed security components. The upper part of the Home tab shows the security status of your 
computer. For example, when the status is shown as Protected, your computer's protection is 
up to date. 

The security levels of the different security components, for example Normal or High, are shown 
next to the name of the component. The lower part of the Home tab shows the date and time of 
last update check. 



By clicking the tabs on the left, you can see the details of all the security components 
(Virus&Spy Protection, Internet Shield, Spam Control, and Automatic Updates). The icons show 
you the status of the program and its security components. If you change program settings, also 
the icons change. 

The icons and 

their meanings:  

 

 

 

A critical security component, for example Virus & Spy Protection, is 
working properly. 

 

 

 

 

One of the security components is not in use, but your computer is still 
protected. 

 

 

 

 

A security component or one of its features is disabled, and your computer 
is not protected. The icon will change back to green when you enable the 
component again. 

 

 

 

 

Your service subscription has expired. 

 

 

 

 

An error state in the software. 

 

 

 



Managing the product settings remotely 

This section explains how you can remotely manage the product settings by assigning profiles 
or operations. 

¶ Assigning profiles 
You can assign a new profile to a computer, for example, to restrict the users of that 
computer from making dangerous changes to the security settings.  

¶ Assigning operations 
You can also assign operations to a remote computer from the portal, for example, 
enable the firewall or real-time virus scanning on a remote computer.  

 

Assigning profiles 

You can assign a new profile to a computer, for example, to restrict the users of that computer 
from making dangerous changes to the security settings. 

There are default profiles for connecting to the Internet from a fixed location (for example, Office 
open, Office locked) and from outside office premises (for example, Laptop open, Laptop 
locked). An open profile allows end users to change security settings; a locked one does not 
allow changes. 

To assign a profile: 

1. In the Computers list, select the computers to which you want to assign a profile.  

2. Click Assign profile. A list of available profiles is shown.  

3. From the list, select a profile.  

4. Click Assign.  

The local operation or profile is applied to the computer the next time the computers checks for 

updates with the F-Secure PSB Portal. 

The remote computer must be on and connected to the Internet to be able to check for pending 
local operations or new profiles. 

 

Assigning operations 

You can also assign operations to a remote computer from the portal, for example, enable the 
firewall or real-time virus scanning on a remote computer. 

To assign an operation: 

1. Select computers from the list by selecting the appropriate checkboxes.  



2. Click Operations. A list of operations appears.  

3. Select one of the following operations from the list:  

Select... To... 

Send full status update force the remote computer to send a full report of 

it's status to the portal. 

Enable Real-time Virus 

Scan 

find and block viruses on the remote computer 

before they can cause harm. 

Enable Real-time Spyware 

Scan 

find and block spyware on the remote computer 

before they can cause harm. 

Set the Virus and Spy 

Protection level to Normal 

select the most commonly applicable level of 

protection from viruses and spyware for the remote 

computer. 

Enable Application 

Control 

let the user decide which applications are allowed 

to access the Internet on the remote computer. 

Set the Internet Shield 

security level to Office 

select the most commonly applicable level of 

protection from unsafe traffic on the remote 

computer. 

4. Click Assign Operation to assign the operation to the remote computer.  

The operation or profile is applied to the computer the next time the computers checks for 
updates with the portal. 

 

 

 

 



Managing profiles 

You can create, edit, or remove profiles using the profile editor. 

¶ About profiles 
Profiles let you control what users can do with the security settings on a computer.  

¶ Creating a profile 
Create a new profile that can be assigned to remote computers.  

¶ Editing a profile 
When you edit an existing profile, the changes that you make are enforced on all the 
computers with that profile.  

¶ Deleting a profile 
You can remove a profile from the list of available profiles.  

¶ Changing profile name or description 
You can rename a profile and edit the description if, for example, the settings of the 
profile no longer agree with the name and description.  

¶ Setting a default profile 
You can set your own default profiles for remote computers.  

¶ Resetting default profiles 
If you have set your own default profiles for remote computers, but you want to restore 
the system default profiles, reset the default profiles.  

 

About profiles 

Profiles let you control what users can do with the security settings on a computer. 

Profiles differ by: 

 

¶ Users' computer skills. A profile for novice users may restrict their rights to change their 
security settings.  

¶ Computer type: laptop or desktop computer. A profile for a laptop computer is designed 
to protect users when they access the Internet from unsafe locations, such as cafes with 
free Internet access. A profile for a desktop computer is designed to protect access to 
the Internet from a fixed location.  

There are predefined profiles that you can apply to computers. If a suitable profile does not exist 
for users, you can create your own profiles. You can use an existing profile as a basis for a new 
profile. You can also add your own default profiles. 

 



Creating a profile 

Create a new profile that can be assigned to remote computers. 

To create a profile: 

1. In the Security Profiles page, click Launch Profile Editor.  

2. Select an existing profile on which to base the new profile. Select a profile that is similar 
to what you want so you do not have to change many settings.  

3. Click the create new profile icon.  

4. In the Profile name field, add a descriptive name for the profile. This name represents 
the profile on the Computers page.  

5. In the Description field, add a description for the profile. You see the description of a 
selected profile on the Computers page when you assign a profile. The description 
should clearly tell all users what the profile does.  

6. Click OK. A new profile with the same settings as the base-profile is added to the Profile 
tree.  

7. You can make changes to the profile by selecting or clearing a setting.  

8. Click the lock icon next to the setting if you want the user to be unable to change the 
setting on the remote computer. You can change a locked setting of a profile only by 
assigning a new profile. Locked settings can be changed neither by the user of the 
remote computer nor by assigning operations.  

9. Repeat the previous steps until the profile has the settings you want.  

10. Click the publish profile icon. You can click the discard changes icon to remove any edits 
that you made and leave the profile with no changes.  

You can now assign this profile to remote computers on the Computers page. 

 

Editing a profile 

When you edit an existing profile, the changes that you make are enforced on all the computers 
with that profile. 

To edit a profile: 

1. Click Launch Profile Editor.  

2. Click Launch Profile Editor in simple mode.  

3. In the Profiles tab, select an editable profile. Profiles that are created by other users are 
locked and you cannot edit them. These profiles have a yellow lock icon next to the 
profile name.  

4. Click the edit profile icon.  

5. In the Settings tab, select one of the groups of settings.  

6. Change a setting:  

a. Select or clear a setting.  



b. If you do not want the user to be able to change the setting on the remote 
computer, click the lock icon next to the setting. The only way to change a locked 
setting of a profile is to send a new profile. Locked settings can be changed 
neither by the user of the remote computer nor by the administrator assigning 
local operations.  

7. Repeat the previous steps until the profile has the settings you want.  

8. Click the save profile icon. If you want to remove any changes you made, click the 
discard changes icon.  

The changes you made to the profile settings are applied to all the computers with this profile 
when they next check with the portal for updates. 

 

Deleting a profile 

You can remove a profile from the list of available profiles. 

To delete a profile: 

1. Select an editable profile from the profile tree. You cannot delete profiles that were 
created by other users. These profiles are locked and have a yellow lock icon next to the 
profile name.  

2. Click the remove profile icon. All sub-profiles are also deleted.  

3. Click OK.  

The selected profile and all its sub-profiles are deleted and no information about the profile is 
available in the portal. The deleted profile is not deleted from the actual workstation. 

 

Changing profile name or description 

You can rename a profile and edit the description if, for example, the settings of the profile no 
longer agree with the name and description. 

To rename a profile: 

1. Select an editable profile from the profile tree on the left. You cannot edit profiles that are 
created by other users. These profiles are locked and have a yellow lock icon next to the 
profile name.  

2. Click the edit profile icon.  

3. Click the profile properties icon.  

4. Edit the profile name and description. You can enter the description in multiple 
languages.  

5. Click OK.  



6. Click the save profile icon. You can click the discard changes icon to remove any edits 
you made and leave the profile with no changes.  

 

Setting a default profile 

You can set your own default profiles for remote computers. 

You can set default profiles separately for workstations and servers. These profiles are applied 
to new computers that you add to the system. If you do not set any default profiles, the system 
default profiles are applied to computers. 

To set a default profile: 

1. On the Security Profiles page, click Set default profiles.  

2. Select a profile that you want to set as the default profile.  

3. Select whether you want to set the profile as a default profile for servers or workstations. 
To do this, select one of the following options:  

o Default profile for workstations  

o Default profile for servers  

4. Click Update. In the Default profiles column, you can view the profiles that you selected 
as the default profiles. They are applied to new computers that you add to the system.  

 

Resetting default profiles 

If you have set your own default profiles for remote computers, but you want to restore the 
system default profiles, reset the default profiles. 

To reset the default profiles: 

1. On the Security Profiles page, click Reset default profiles.  

2. Click Reset default profiles. Your own default profiles are cleared from the Default 
profiles column, and the system default profiles are shown instead. The system default 
profiles are applied to new computers that you add to the system.  

 

Frequently asked questions 

This chapter answers the most frequently asked questions. 

If you do not find answers to your questions here, please contact support. 

 

 



Q. How can I change the language in my F-Secure PSB Portal? 

A. To change the language, first log in to the F-Secure PSB Portal, click your user name at the 
top right corner. In the Edit account page, from the Language drop-down list, select the 
language that you want, and click Submit. 

Q. When do I need to create my own security profile? 

A. You need to create a new security profile if none of the F-Secure predefined profiles matches 
the needs of your end customers. For example, if you have a program on your computer that 
slows down too much because of real time scanning operations, you need to create a profile in 
which that program is excluded from scanning. Or if a network software such as a VPN client 
cannot connect to the Internet with the default firewall rules, you must create a new security 
profile with specific firewall rules for the software. 

Q. How can I use RSS feeds? 

A. For instructions on how to use RSS feeds, see the Get Updates by RSS section in chapter 
'Checking the system status'. 

Q. Can I get reports out from the F-Secure PSB Portal? 

A. You can export information about your network computers on the Export data tab (under the 
Computers tab). On the Reports tab, you can currently only view information about your network 
computers, such as overall protection status and status by each security component. 

 


